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Introduction

LibreOffice can be used without requiring a pointing device, such as a mouse or trackball, by
using the keyboard shortcuts that are available in Draw. Tasks as varied and complex as docking
and un-docking toolbars and windows, or changing the size or position of objects can all be
accomplished with using keyboard shortcuts. Although LibreOffice has an extensive set of
keyboard shortcuts, each LibreOffice module has keyboard shortcuts that are specific to that
module.

For help with LibreOffice keyboard shortcuts, or using LibreOffice with a keyboard only, search
the LibreOffice Help using the “shortcut” or “accessibility” keywords.

In addition to using keyboard shortcuts that are listed in this appendix, keyboard shortcuts can
also be defined. Assign keyboard shortcuts to standard Impress functions or macros and save
them for use with Draw only, or with the other modules in LibreOffice. To customize keyboard
shortcuts, see the Getting Started Guide for more information.

Note

Some keyboard shortcuts are not available for computers using macOS and are
indicated in the following tables by a blank cell.

Draw function key and keyboard shortcuts

Draw function keys

M{m L macOS Effect
Linux
F1 F1 Opens LibreOffice Draw help.
Switches to text edit mode and opens the Text
F2 F2 .
Formatting toolbar.
F3 F3 Enters a group of objects for editing.
Shift + F3 Shift + F3 Opens the Duplicate dialog of a selected object.
Ctrl + F3 ¥ +F3 Exits a group of objects.
E4 F4 Op_ens the Position and Size dialog of a selected
object.
F5 F5 Opens the Navigator.
Forward navigation of the emphasis within the on
F6 F6
screen elements.
Shift + F6 Shift + F6 Backward navigation of the emphasis within the on
screen elements.
Starts the spelling checker. Only available in text
F7 F7 "
editing mode.
Shift + F7 Shift + E7 Sw(cches on or off t_h_e automatic spell checking. Only
available in text editing mode.
Ctrl + E7 38 + F7 Opens the The_saurus_ dialog qu the language being
used. Only available in text editing mode.
F8 F8 Opens the Edit Points toolbar.
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Windows

Linux macOS Effect
Ctrl + Shift + F8 ¥ + Shift + F8 Fits text to frame of a selected object.
Shift + F10 Shift + F10 Opens the context menu of a selected object.
F11 ¥+T Opens the Styles deck on the Sidebar.
Draw keyboard shortcuts
Z‘I{Lnu‘iows macOS Effect
Plus (+) Zooms in.
Minus (-) Zooms out.
r::mﬁfegxp)) aodn Fits the drawing to fill the Workspace view.
Divide (=) on Zooms in on the selected object.
number pad
Ctrl + Shift + G ¥ + Shift + G Groups selected objects.
Shift + Ctrl + Alt %+ S.hift Ungroups selected group.
+ G + Option + G
Ctrl + Shift + K ¥ + Shift + K Combines selected objects.
Ctrl + Shift + Alt ¥ + Shift Splits a selected object that has been combined from a
+ K + Option + K group of two or more objects.
Ctrl + + ¥ ++ Brings current selection forward.
Ctrl +Shift + + 3 + Shift + + Brings current selection to the front.
Ctrl + - 3 +- Sends current selection backward.
Ctrl + Shift + - 3 + Shift + - Sends current selection to the back.
Page Up sa\i\gtec.hes to previous page. No function on the first
Page Down Switches to next page. No function on the last page.
Ctrl+Page Up Switches to previous layer.
Ctrl+Page Down Switches to next layer.
Arrow Arrow Moves a selected object in the direction of the arrow.
Ctrl+Arrow Ctrl+Arrow Moves the page view in the direction of the arrow.
Loaron | LotArow | Vi Fages Pane seeced suiches e e prevous
Right Arrow Right Arrow With Pages Pane selected, switches to the next page

in a drawing. No function on the last page.
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Windows

Linux macOS Effect
Shift Shift When selectl_ng object.s, adds or removes object to or
from a selection of objects.
Hold down Shift then click and drag a selection handle
Shift Shift when resizing an object to maintain the proportions of
the object.
. . Hold down the Shift key while moving a selected object
Shift Shift . . :
to constrain the movement in multiples of 45 degrees.
Hold down the Shift key before selecting several
Shift Shift adjacent objects or characters. Click at the start of a
selection, move to the end of the selection.
Hold down the Ctrl (36) key, then click and drag a
selected object to create a copy of the object. Note that
ctrl 58 this shortcut works only when the Copy when moving
option in LibreOffice > Preferences > LibreOffice
Draw > General is enabled (this option is enabled by
default).
. Hold down the Alt (Option) key and draw or resize an
Alt Option object from the centre of the object.
Alt Option Hold down the Alt (Option) key when selecting an
P object that is behind the currently selected object.
. . . Hold down the Alt (Option) + Shift keys when selecting
Alt+ Shift Option + Shift an object that is in front of the currently selected object.
Tab Tab Selects objects in the order in which they were created.
Shift + Tab Shift + Tab Selects objects in the reverse order in which they were
created.
Esc Esc Exits current mode.
Enter Enter Enters text mode if a text object in the drawing is
selected.
Ctrl + Enter $8 + Enter Inserts a new page after the selected page in a

drawing.

Home/End

Selects the first/last page in a drawing.

Editing text keyboard shortcuts

Windows

. macOS Effect

Linux

Ctrl + - 8 + - Inserts a custom hyphen (soft hyphen) in text at the
cursor position.

Ctrl + Shift + - $8 + Shift + - Inserts a non-p(eaklng hyphen (hard hyphen) in text at
the cursor position.

Ctrl + Shift + 38 + Shift + Inserts a non-breaking space, which is not used for

Space Space hyphenation and is not expanded if the text is justified.

Shift + Enter Shift + Enter Inserts a line break without paragraph change.
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Windows
Linux

macOS

Effect

Left arrow

Left arrow

Moves the cursor one character to the left.

Shift + Left arrow

Shift + Left arrow

Moves the cursor one character to the left and selects
the character.

Ctrl + Left arrow

Option + Left
arrow

Moves the cursor to the beginning of the previous
word.

Ctrl + Shift + Left Option + Shift + Moves the cursor to the left and selects the word on
arrow Left arrow the left.

Right arrow Right arrow Moves the cursor one character to the right.

Shift + Right Shift + Right Moves the cursor one character to the right and selects
arrow arrow the character.

Ctrl + Right arrow

Option + Right
arrow

Moves the cursor to the beginning of the next word.

Ctrl + Shift + Option + Shift + Moves the cursor to the right and selects the word on
Right arrow Right arrow the right.
Up arrow Up arrow Moves the cursor up one line.

Shift + Up arrow

Shift + Up arrow

Moves the cursor up one line in the text and selects
the lines of text.

Ctrl + Up arrow

Option + Up
arrow

Moves the cursor to the beginning of the paragraph.

Ctrl + Shift + Up

Option + Shift +

Moves the cursor to the beginning of the paragraph.
Selects the text in the paragraph from the cursor

arrow Up arrow position to the beginning of the paragraph.

Down arrow Down arrow Moves the cursor down one line.

Shift + Down Shift + Down Moves the cursor down one line in the text and selects

arrow arrow the lines of text.

gr%':/ Down ¥ + Down arrow Moves the cursor to the end of the paragraph.

Ctrl + Shift + Opt + Shift + Moves the cursor to the end of the paragraph._SeIects
the text in the paragraph from the cursor position to the

Down arrow Down arrow
end of the paragraph.

Home Moves the cursor to the beginning of the line.

Shift + Home Moves the cursor to the beginning qf_ the line and
selects the text from the cursor position.

Ctrl + Home Move_s the cursor to the beginning of the text block on
the slide.

End Moves the cursor to the end of the line.

Shift + End Moves the cursor to the_e_nd of the line and selects the
text from the cursor position.

ctrl + End Moves the cursor to the end of the text block on the

slide.
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Windows

Linux macOS Effect

ctrl + Del Deletes the text from the cursor position to the end of
the word.

Ctrl + Shift + Del Deletes the text from the cursor position to the end of

the sentence.

Ctrl + Backspace

&8 + Backspace

Deletes the text from the cursor position to the
beginning of the word.

Ctrl + Shift +
Backspace

38 + Shift +
Backspace

Deletes the text from the cursor position to the
beginning of the sentence.

Menu function key and keyboard shortcuts

The function key and keyboard shortcuts listed in the following tables are available in each menu

category on the Menu bar. The tables give the menu item or sub-item, operating system validity,
and the effect or purpose of the shortcut.

Note
The menus listed below are in the same order as displayed on the Menu bar from left
to right.
File menu
MenL_l item or Vl{mdows macOS Effect
sub-item Linux
Open Ctrl+0 8 +0 Opgns _the Open file brows_er aIIowmg
navigation to a folder and file selection.
Save Ctrl+ S #+S Saves the open drawing.
Opens the Save as file browser
Save As Ctrl + Shift + S 3 + Shift+ S allowing navigation to a folder and
saving the open drawing as a new file.
Print Ctrl + P 8+ P Opens_ the Print dialog aII_OW|_ng _
selection of how the drawing is printed.
Edit Menu
Menu item or Windows
sub-item Linux B0 et
Undo Ctrl+Z ¥ +Z Undoes the previous editing action.
Redo Ctrl + Y 5 +Y Reverses the action of the last Undo
command.
cut Ctrl + X 38 + X Deletes thg selected object and places
it on the clipboard.
Copy Ctrl + C £ +C Copies the selected object to the

clipboard.

8 | Appendix A, Keyboard Shortcuts




Menu item or

Windows

Optional Break

sub-item Linux LEIE0 S

Paste Ctrl + v 8 +V/ Places the object on the clipboard into
the drawing.

. Pastes the contents of the clipboard at
Paste Special the cursor position in a format that is
> Paste Ctrl + Shift + V| 38 + Shift + V rsor .
; specified using the Paste Special

Special )
dialog.

Select All Ctrl+ A B +A Selects all objects in a drawing.
Opens the Edit Points toolbar if there is

. an object on the drawing that uses

Points F8 F8 editable points, for example a freeform

line.
View menu

MenL_l item or M{mdows macOS Effect

sub-item Linux

Rulers Ctrl + Shift + R 38 + Shift + R Switches the rulers off and on in the
Workspace.

Sidebar Ctrl + F5 Opens or closes the Sidebar.

Styles 11 %+ T O_pens or closes the Styles deck on the
Sidebar.

Navigator F5 F5 Opens the Navigator.

Insert menu

Menu item or Windows

sub-item Linux LEIE0 S
Switches to text edit mode and opens

Text Box F2 F2 the Text Formatting toolbar.

Hyperlink Ctrl + K ¥} +K Opens the Hyperlink dialog.

Comment Ctrl + Alt + C 3 + Option + Inserts a new comment box onto the

C selected page.

Formatting

Mark > Insert Ctrl + Shift + 3 + Shift + Inserts a non-breaking space at the

non-breaking Space Space cursor position.

space

Formatting

I\N/I:rrrko:v Insert Alt + Shift + Alt + Shift + Inserts a narrow non-breaking space at

No-break Space Space the cursor position.

Space

Formatting

Mark > Inserts a narrow no-width optional break

No-width Curl+/ #®+/ at the cursor position.
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Format menu

Bring Forward

Mem! item or Vl{lndows macOS Effect
sub-item Linux
Text > Bold Ctrl+B ¢ +B Applies Bold format to selected text.
Text > Italic Ctrl +1 3 +1 Applies Italic format to selected text.
Text > Reduces the font size of the selected
. Ctrl + Shift + P 38 + Shift + P text and raises the text above the
Superscript .
baseline.
Text > Reduces the font size of the selected
. Ctrl + Shift + B 3 + Shift + B text and lowers the text below the
Subscript X
baseline.
;?Zxé > Increase Ctrl +] 3 +] Increases the point size of selected text.
Text > _ Ctrl + [ % +[ Decreases the point size of selected
Decrease Size text.
Spac!ng > Line Ctrl + 1 %€ + 1 Set_s the !lne spacing in a paragraph to
Spacing 1 a single line.
Spac!ng Line Ctrl+ 5 £ +5 Sets the line spacing in a paragraph to
Spacing 5 one and half lines.
Spac!ng > Line Ctrl + 2 8 + 2 Sets'the line spacing in a paragraph to
Spacing 2 two lines.
Align Text > Ctrl + L €+ S_ets the paragraph alignment to left
Left aligned.
Align Text > Ctrl+ E 8 +E S(_ets the paragraph alignment to center
Center aligned.
AI_|gn Text > Ctrl + R £ + R S(_ats the paragraph alignment to right
Right aligned.
A||gr.]-Text> Ctrl +J € +J _Set_s_the paragraph alignment to
Justified justified.
Clear D|_rect Ctrl + M Ctrl + M Removes _dlrec'F formattl_ng that has
Formatting been applied without using styles.
Styles > Opens or closes the Styles deck on the
Manage Styles Fl1 #+T Sidebar.
Position and Opens the Position and Size dialog of a
. F4 F4 ;
Size selected object.
Shape menu
Mem_l item or Vl{mdows macOS Effect
sub-item Linux
Arrange > Ctrl + Shift + + 38 + Shiff + + Moves qselected object to the front of
Bring to Front other objects.
Arrange > Ctrl + + 8+ + Moves a selected object in front of the

forward object.
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Menu item or

Windows

sub-item Linux LEIE0 S
Arrange > : .
Send Ctrl + - 58 + - Moves a selected object behind the
backward object.
Backward
Arrange > ; ) Moves a selected object to the back of
Send to Back Ctrl + Shift + - 9% + Shift + - other objects.
Group > Group Ctrl + Shift + G 3 + Shift + G Groups selected objects.
Group > Curl + Alt + g+ Option + Ungroups selected grou
Ungroup Shift + G Shift + G group group.
group > Enter F3 F3 Enters a group of objects for editing.
roup
Group > Exit : .
Group Ctrl + F3 ¥ +F3 Exits a group of objects.
When an object is selected, opens the
Duplicate Shift + F3 Shift + F3 Duplicate dialog, which provides options
for duplicating the selected object.
Tools menu
Mem_l item or Vl{mdows macOS Effect
sub-item Linux
. Starts spelling checker. Only available
Spelling F7 in text editing mode.
Automatic Spell Switches on or off the automatic spell
. P Shift + F7 Shift + F7 checking. Only available in text editing
Checking
mode.
Opens the thesaurus dialog for the
Thesaurus Ctrl + F7 ¥} +F7 language being used. Only available in
text editing mode.
Extension Ctrl+ Alt + E ¥} +At+E Opens the Extension Manager dialog.
Manager
Options Alt+F12 Opens the Options LibreOffice dialog.
Windows menu
Menq item or Vl{mdows macOS Effect
sub-item Linux
Closes Window | Cirl + W 8 + W Closes the active window. If there is

only one window, closes Draw.
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Help menu

Mem_l item or Vl{lndows macOS Effect

sub-item Linux

LibreOffice E1 E1 Opens your browser application at the
Help LibreOffice Help pages.

General function key and keyboard shortcuts

Opening menus and menu items

Windows
Linux

macOS

Effect

Alt + <?2>

Press the Alt key first, then select the underlined character
of the menu to be opened. The <?> is the underlined
character in the menu. For example, Alt+F opens the File
menu.

With the menu open, menu items have an underlined
character. To access these menu items directly, press the
underlined character key. Where two menu items have the
same underlined character, press the character key again
to move to the next item.

If an item in a menu has no underlined character, click on
the menu item directly.

Esc

Esc

Closes an open menu.

F6

F6

Repeatedly pressing F6 cycles the focus through the
following objects:

Menu bar (Windows and Linux operating systems only)
Each toolbar from top to bottom and from left to right
Each free window from left to right

Drawing

Shift + F6

Shift + F6

Repeatedly pressing Shift+F6 cycles the focus in the
opposite direction.

Ctrl + F6

Ctrl + F6

Cycles the focus back to the drawing.

F10

Switches the access on or off for the Menu bar.

Accessing Menu bar commands

* Press F6 to select the first item on the Menu bar (the File menu).
* Press the right arrow to select the next menu to the right.
* Press the left arrow to select the previous menu to the left.

* Press the Home and End keys to select the first or last item on the Menu bar.

* Press the down arrow to open a selected menu. An additional press on the down arrow
or up arrow moves the selection through the menu commands.

* Press the right arrow to open any submenus on the selected menu. Submenus are
indicated by a triangle » next to the menu item.

* Press Enter to execute the selected menu command.
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Accessing toolbar commands
* Press F6 repeatedly until the first tool on a toolbar is selected.

* Use the right and left arrows to select a tool on a horizontal toolbar, or the up and down
arrows to select a tool on a vertical toolbar.

* Press the Home key to select the first tool on a toolbar, or the End key to select the last
tool on a toolbar.

» Press Enter to activate the selected tool.

* Press the right arrow to open any sub-toolbar on the selected toolbar. Sub-toolbars are
indicated by a triangle v next to the tool.

* Keep pressing the right arrow to select a tool on a sub-toolbar.
» Press Ctrl+Enter to insert the selected draw object. The draw object is placed in the

center of the drawing, with a predefined size.
Controlling dialogs

When any dialog is opened, one element (for example a button or option field) indicates it has
focus by highlighting, a check mark, or a dotted box around the field or button name.

Vl{mdows Effect
Linux
Activates the selected option. Where no option is selected, Enter is
Enter . S
the equivalent to clicking on OK.
Esc Closes a dialog without saving any changes made while it was

open, the equivalent to selecting Cancel.

Moves focus up and down a list.
Up or down arrow keys Increases or decreases the value of a variable.
Moves focus vertically within a section of dialog.

Left or right arrow keys Moves focus horizontally within a section of a dialog.

Tab Advances focus to the next section or element of a dialog.
Shift + Tab Moves the focus to the previous section or element in a dialog.
Alt + Down Arrow Shows the options available in a drop-down list.

Checks or selects an empty checkbox.

Spacebar Clears or deselects a checked checkbox.

Toolbar function key and keyboard shortcuts

Draw provides several toolbars for the creation and editing of drawings. Some tools on the Draw
toolbars can be activated using a function key or keyboard shortcut.

Note

The Draw toolbars are listed in the same order displayed in the context menu that is
opened by going to View > Toolbars on the Menu bar.
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Drawing

Windows
Tool name Linux Effect
macOS
Insert Text Box E2 Switches to text edit mode and opens the Text Formatting
toolbar.
Opens the Edit Points toolbar if there is an object on the
Edit Points F8 drawing that uses editable points, for example a freeform
line.
Find
Tool name I/I{mdows macOS Effect
Linux
Find and # + Option + Finds and replaces all instances of text
Ctrl+ H . .
Replace H in a drawing.
Form Design
Tool nhame M{mdows macOS Effect
Linux
Bring to Front Ctrl + Shift + + 38 + Shift + + Moves a selected object to the front of
other objects.
Send to Back Ctrl + Shift + - $8 + Shift + - Moves a selected object to the back of
other objects.
Group Ctrl + Shift + G ¥ + Shift+G Groups selected objects.
Ctrl + Alt + 36+ Option +
Ungroup Shift + G Shift + G Ungroups selected group.
Enter Group F3 F3 Enters a group of objects for editing.
Exit Group Ctrl + F3 ¥ +F3 Exits a group of objects.
Image
Tool name M{mdows macOS Effect
Linux
Position and Opens the Position and Size dialog of a
) F4 F4 ;
Size selected object.
Bring to Front Ctrl + Shift + + S8 + Shift + + Moves gselected object to the front of
other objects.
Bring Forward Crl + + 38 + + Moves a sglected object in front of the
forward object.
Send Moves a selected object behind the
Backward Ctrl + - % +- backward object.
Send to Back Ctrl + Shift + - S8 + Shift + - Moves a selected object to the back of

other objects.
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Line and Filling

Tool name W' ke macOS Effect
Linux
Position and Opens the Position and Size dialog of a
) F4 F4 .

Size selected object.

Bring to Front Ctrl + Shift + + 3 + Shift + + Moves a selected object to the front of
other objects.

Bring Forward Cirl + + 8 + + Moves a sglected object in front of the
forward object.

Send Moves a selected object behind the

Backward Ctrl + - ¥ +- backward object.

Send to Back Ctrl + Shift + - $8 + Shift + - Moves a_selected object to the back of
other objects.

Styles F11 E+T Opens the Styles deck on the Sidebar.

Standard
Tool nhame Vl{mdows macOS Effect
Linux

New Ctrl+ N ¥} +N Opens a new drawing.

Templates Ctrl + Shift + N 3 + Shift + N Opens ”“? Templates dialog to create a
new drawing using a template.
Opens the Open file browser to allow

Open Ctrl+ O #+0 navigation to a folder and selection of a
drawing.

Save Ctrl+ S #d+S Saves the open document.

Save As Ctrl + Shift + S 38 + Shift + S Opens the Sa\(e as file browser to save
the open drawing as a new drawing.

Edit Mode Ctrl + Shift + M S8 + Shift + M _Svyltches on edit mode when a drawing
is in read only mode.

Print Ctrl + P 38 + P Opens the Prl.nt dialog to select how to
print the drawing.
Deletes the selected object and places

Cut Crl + X % +X it on the clipboard.

Copy Ctrl + C £ +C Cpples the selected object to the
clipboard.

Paste Cirl + v 38 +V/ Places the object on the clipboard into
the document.

Clear Ctrl + M Ctrl + M Removes .dlrec'g formattl_ng that has
been applied without using styles.

Undo Ctrl+Z ¥ +Z Undoes the previous editing action.

Redo Ctrl + Y 5 +Yy Reverses the action of the last Undo

command.
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Windows

Tool nhame . macOS Effect
Linux
. Starts the spelling checker. Only
Spelling F7 F7 available in text editing mode.
Auto Switches on or off the automatic spell
Shift + F7 Shift + F7 checking. Only available in text editing
Spellcheck
mode.
Switches to text edit mode and opens
Text Box F2 F2 the Text Formatting toolbar.
Insert Hyperlink | Ctrl + K #+K Opens the Hyperlink dialog.
Position and Opens the Position and Size dialog of a
) F4 F4 i
Size selected object.
Opens the Edit Points toolbar if there is
Edit Points Es Es an_object on the drawing that uses
editable points, for example a freeform
line.
Standard (Viewing Mode)
Tool name Vl{mdows macOS Effect
Linux
Opens the Save as file browser so you
Save As Ctrl + Shift + S 3 + Shift + S can save the open document as a new
document.
Edit Mode Ctrl + Shift+M | 3 +Shift+ M | SWitches on edit mode when a
document is in read only mode.
Opens the Print dialog so that you can
Print Ctrl + P ¥ +P select how you want to print the
document.
Copy Ctrl + C % +C Cpples the selected object to the
clipboard.
Find and Ctrl+ H 3 + Option + F | Opens the Find and Replace dialog.
Replace
Text Formatting
Tool name r{mdows macOS Effect
inux
Increase Ctrl +] 3 +] Increases the point size of selected text.
Decrease Ctrl + [ % +[ tIi}()e((t:reases the point size of selected
Bold Ctrl + B ¥ +B Applies Bold format to selected text.
Italic Ctrl + 1 &+ Applies Italic format to selected text.
Reduces the font size of the selected
Superscript Ctrl + Shift + P Ctrl + Shift + P text and raises the text above the

baseline.
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Tool nhame llil(mdows macOS Effect
inux

Reduces the font size of the selected

Subscript Ctrl + Shift + B Ctrl + Shift + B text and lowers the text below the
baseline.

Clear Ctrl + M Ctrl + M Removes _d|rec'g formattl_ng that has
been applied without using styles.

Left Ctrl + L 58 + L S(_ets the paragraph alignment to left
aligned.

Center Ctrl + E 8+ E Sgts the paragraph alignment to center
aligned.

Right Cirl + R £ + R Sgts the paragraph alignment to right
aligned.

Justified Ctrl +J 58 +J _Set_s_the paragraph alignment to
justified.

Select All Ctrl + A ¥}k +A Selects all the text in a text box.
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